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Chapter1 

Getting Started 

Minimum Hardware Requirements 
 

Before installing the DDC Monitor program,  you will need at least 10 Megabytes of available disk space, and 
the following minimum hardware requirements should be met:  

 

MINIMUM Hardware Requirements: 

• 80486DX 33 MHz (80486DX 66 MHz suggested) 

• 8 megabytes of RAM 

• VGA Color Monitor 

• 1 Available Serial port 

• Mouse or any pointing device supported by Windows 

• Windows 3.1, Window for Workgroups 3.11, or Windows 95 

 

Installing the DDC Monitor Software 
 

To install the DDC monitor, place the installation disk into a 3.5” floppy drive on your computer. Select Run 
from the Program Manager File menu as shown in the following figure.  You will be prompted to enter a file 
name;  type “A:\SETUP” (if you are installing from the B drive, type “B:\SETUP”) and press ENTER. 

 

             
Selecting RUN  from the Program Manager 
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The SETUP program will begin to lead you through the installation process. 

 
Setup Program 

You will be asked to choose a directory in which you would like the program installed.  The default 
“C:\WDDCMON” is suggested.  A different location can be chosen by either entering a new name or by 
selecting an existing directory from the list.  If the chosen directory does not already exist, it will be created 
automatically.  Press OK to continue. 

 
Selecting a Destination Directory for Program Files 

Next you will be asked if you want to backup any files overwritten during the installation process.  For first 
time installations, press No to skip this step.  If you are upgrading to a newer version, press Yes and the 
installation program will prompt you to select a backup directory. 

The installation program will begin copying the program files to your computer.  This operation can be 
stopped by pressing Cancel at any time.  When all program files have been installed, you will be asked if you 
would like icons added to your Program Manager.  Select YES and the screen shown on the following page 
will be displayed prompting you to choose a Program Group for the icons. If you are installing under Windows 
95 you will be asked if you want shortcuts added to the start menu and, in this case, you will not be prompted 
to select a Program Group. 
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Selecting a Program Group for Icons 

The default Program Group, “Environmental Technologies”, is suggested.   A different group can be chosen by 
either entering a name or selecting an existing group from the list.   Press  “OK” and the icons will be 
installed.  The installation is now complete.   

 
 

 
Icons installed in the Windows Program Manager 

 
 

Uninstalling the DDC Monitor Software 
 

The DDC Monitor Program comes with built in uninstall capabilities.  The installation can be reversed by 
running the “Uninstall DDC Monitor” program.  All programs and system modifications (except directories) 
made during the installation process will be removed.  To run the Uninstall program, double click on the 
“Uninstall DDC Monitor” Icon in the DDC Monitor Program Group.  Afterwards, you can remove any 
remaining directories using the Windows File Manager. 
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Chapter2 

Communcations Setup 

Direct Connect Communications 
 
Equipment Needed 
A direct connection can be used only in situations where it is possible to physically connect a computer and 
one of the DDC network controllers using a cable.  To establish a direct connection with a DDC system using 
the Windows DDC Monitor Software, the following equipment is required: 

 
1. An IBM compatible computer with a copy of Windows DDC Monitor software installed. 
2. An ETINT1 interface cable included in the ETCOMPAC communication package.  This cable has a 9 

pin female D-Connector (DB9F) on one end and a 6-pin male Quick-Connect jack with transmit and 
receive lights on the other end. 

3. A QW6N 6 foot communication cable included in the ETCOMPAC communication package.  This 
cable has a 6 pin female Quick-Connect plug on each end. 

 

Setting up Communications 
1. Insert the ETINTI cable’s 9 pin female connector into the computer’s serial communication port.   
2. Insert one end of the QW6N cable into the free end of the ETINT1 cable.   
3. Plug the free end of the QW6N cable into the 6 pin communication port on any system controller 

(SCU, BTC, Zone, or Operators Panel). 

Computer Serial
Port

(COM1 - COM4)
ETINT1 QW6N Quick Connect Jack

(SCU, Zone, etc.)

 
Figure 1. Direct Connect Cable Configuration 

Remote Modem Communications 
A modem can be used to establish a connection with a DDC system is situations where it is not possible to 
directly connect a computer and one of the network controllers.  To establish a remote connection using the 
Windows DDC Monitor Software.  The equipment needed and steps required to setup communications are 
listed in the following sections. 

Equipment Needed 
Remote (DDC side) Equipment 
1. An ETINT1 interface cable (described in preceding section). 
2. A QW6N interface cable (described in preceding section). 
3. An ETNULLl cable.  This is a 9 pin male (DB9M) to 25 pin male (DB25M) null modem cable . 
4. An External Hayes Compatible Modem capable of 2400 baud connections. 
5. Any additional cables and connectors that might be needed to connect the PC, Modem, and phone 

line (modem cable, gender changers, phone line extension, etc.). 
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Local (PC side) Equipment 

1. A Hayes Compatible Modem capable of 2400 baud connections. 
2. An IBM PC compatible computer with at least one available serial port.  The port cannot be using 

a shared interrupt or have any other hardware conflicts with other devices on the computer. 
3. Any additional cables and connectors that might be needed to connect the PC, Modem, and phone 

line (modem cable, gender changers, phone line, etc.). 

Setting up Communications 

Remote (DDC side) Setup 
1. Configure the External modem using the Modem Setup program described elsewhere in this 

manual. 
2. Plug one end of the QW6N interface cable into any quick connect jack on the DDC system.  

These 6 pin male jacks are located on every SCU, BTC, Zone Controller, Operator's Panel, and 
Thermostat. 

3. Plug the free end of the QW6N interface cable into the Quick Connect jack on the ETINT1. 
4. Plug the 9 pin (DB9F) connector on the ETINT1 cable into the 9 pin (DB9M) connector on the 

ETNULL1 modem cable. 
5. Plug the 25 pin end of the ETNULL1 into the External Hayes Compatible Modem.  Most 

modems have a 25 pin (DB25F) connector.  If yours does not, you will need to purchase a  
“converter” with a 25 pin female (DB25F) on one end and the appropriate modem connector on 
the other end.   

6. Finally, connect the modem to a phone line using the appropriate telephone cable which is 
usually included with the modem. 

  

Quick Connect
Jack

 (SCU, BTC, etc)
 ETINT1  ETNULL1 ModemQW6N

 

Remote Communications DDC Cable  Setup 

Local (PC side) Setup 

Follow the installation instructions included with your Modem describing how to connect the Modem 
to a PC.  Note the Serial Port number (i.e. COM1) used for communications to this Modem.   

Before attempting to use the modem with the DDC Network, test it using the communications 
software included with it or by using the Windows terminal program.  If it does not work, consult the 
troubleshooting section of the modem installation manual or contact the manufacturer.



Guide to Using the DDC Network Software The DDC Monitor Program  •  7 

Chapter 3 

The DDC Monitor Program 

Starting the Program 
This program uses a large number of standard and custom Windows controls including Buttons, Edit Boxes, 
Check Boxes, Drop Down Lists, and Tabs for Multipage Dialog Boxes.  If you are a new Windows user it may 
help review your Windows manual before using this program.  There is also a good tutorial included with most 
versions of Windows. 

To run the Windows DDC Monitor, double click on the DDC Monitor Icon in the  DDC Monitor Program 
Group.  The main program screen will be displayed.  If no user action is taken within a few seconds, the 
“Connect to Network” dialog box will open automatically.  After the program has been properly configured, 
this allows the user to quickly establish a network connection by simply running the program and pressing 
ENTER when the “Connect to Network” dialog appears. 

 

The Main Screen 

 
DDC Monitor Main Screen 

Menu Bar 

File Menu 
Close - Closes the active controller window. 

Load Configuration - Loads a controller configuration from a file. 

Save Configuration - Saves a controller configuration to a file. 

Print - Prints the current screen. 

Print Setup - Selects and configures the printer used by this program. 

Exit - Closes and open windows and exits the program. 
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Network Menu 
Connect to Network - Opens the “Connect to Network” dialog. 

Lock Controls - Locks and Unlocks the controls on a controller configuration screen. 

 

Options Menu 
Program - Opens the “Program Options” dialog. 

Communication Stats - Opens the “Communication Stats” dialog.  This dialog box displays 
the number of communication attempts, failures, and percent failures.  Properly installed 
systems with good communications should have less than 1% errors. 

 

Help Menu 
Contents - Opens the Help File contents page. 

Search for Help On - Opens the Help File search engine dialog. 

About - Opens a dialog that displays version and copyright information about the program. 

 

Speed Button Bar 
Buttons used a shortcuts for menu commands.  The following buttons, listed from left to right, are available. 

Load Configuration Button - Shortcut for the Load Configuration command on the File Menu. 

Save Configuration Button - Shortcut for the Save Configuration command on the File Menu. 

Connect to Network Button - Shortcut for the Connect to Network command on the Network 
Menu. 

Print Button - Shortcut for the Print command on the File Menu. 

Exit Button - Shortcut for the Exit command on the File Menu. 

Help Button - Shortcut for the Search for Help On command on the Help Menu. 

 

Status Bar 
Displays the following program status information. 

Status Line - Displays program status during lengthy operations.   

Polling Progress Bar  - In addition to displaying information in the Status Line, this bar will be 
displayed to indicate the progress of the current polling cycle. 

Polling Timer - Used to indicate the amount of time, in seconds, before the next polling cycle.  The 
polling cycle starts when this timer reaches approximately 55 seconds.
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Chapter 4 

Program Options 

Opening the Program Options Dialog 
 

Before logging on to DDC system, program options must be set.  These options tell the program how to 
establish a connection to the DDC network.  If the Connect to Network Dialog is open, press Cancel.   
Select  Program from the Options menu to open the Program Options Dialog.  The three pages of options, 
connection, communication, and general, are available.  Individual pages can be selected by pressing the 
appropriate tab located near the bottom of the dialog box. 

Connection Options 
To access the Connection Options page, select the “Connection” tab located near the bottom of the Program 
Options dialog box.  The following screen will be displayed. 

 

 
Connection Options 

Serial Interface 
The program has the ability to communicate with the DDC network using a Quick-Connect cable 
plugged directly into a network controller or by using a modem to call a remote system. 

Cable - A Quick-Connect is used for network communications. 

Modem - A modem is used for network communications. 

Network Interface  
Two different cable configurations can be used to interface with the DDC network.  The standard 
Quick-Connect cable plugs into one of the 6 pin female connectors on an SCU, BTC, Zone 
Controller, Thermostat, or Operators Panel.  There is an optional connector (ETRS) which allows a 
Quick-Connect cable to be plugged into the communications bus on a zone controller.  This is known 
as a front end connection. 
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Quick Connect - The computer is connected to the network (2400 baud) using a Quick 
Connect cable.  

Front End - The computer is connected to the network (9600 baud) using a Front End cable. 

Network Mode 
There are two different network communication modes are available.  In Local mode, the program can 
only a communicate with the system into which the Network Interface cable is plugged.   If the cable 
is plugged into zone 105, only the controllers with system address 100 will be visible: SCU #100, 
BTC #165, and Zones #101 - #164.  In Inter-System mode, any controller connected to the network 
can be accessed.  Normally, Inter-System mode should be used.  However, Local Mode does provide 
one very important advantage.  Several computers, each using Local Mode to monitor a different 
system, can be connected to the network simultaneously.  This is possible because communication 
packets are not passed between systems  in Local Mode.  In Inter-System mode, packets are passed 
between systems.  Errors will occur if more than one computer is connected to the network in Inter-
System mode due to packet collisions. 

Local  - Set the network mode to Local (single system). 

Inter-System - Set the network mode to Inter-System. 

Network Cards 
In order to establish a network connection, the software must search for a Network Card (controller).   
This is done by searching for an SCU.  If an SCU cannot be found,  it will search for a BTC.  Finally, if 
a BTC cannot be found, it will begin searching for a zone controller.  Response time can be greatly 
improved by selecting only the available controllers and thus avoiding unnecessary searches. 

System Control - The network has at least 1 System Control Unit. 

Bypass Terminal  - The network has at least 1 Bypass Terminal Controller. 

Zone - The network has at least 1 Zone Controller. 

Communication Options 
To access the Communications page, select the “Communications” tab located near the bottom of the Program 
Options dialog box.  The following screen will be displayed. 

 
Communication Options 
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Serial Port 
Select the computer serial port used for DDC network communications.  The selected serial port 
must be unused by any other device.  It must also be setup properly in the computer CMOS 
configuration and in the Windows communication port settings.  It is especially important to set the 
serial port address and interrupt correctly.  There must also be no conflict with any other device.  The 
standard IBM compatible PC can have up to 4 communication ports, but by default COM1 and COM2 
share interrupts with COM3 and COM4.  If you have a serial mouse on COM1 and try to use COM3 
for this program it will probably not work because, by default, they share the same interrupt. 

 

Modem  
Modem - Select the modem used for remote connections.  If the modem being used does 
not exist, select the closest match; preferably the same manufacturer and product line.  If the 
selected modem does not work properly, a new Modem can be added to the database using 
the Modem Setup program described elsewhere in this manual. 

Special Mode (Read Only) - The ETVT special mode command.  Currently, the DDC system 
can connect only at 2400 baud using a remote modem connection.  The remote modem must 
also be set to answer incoming phone calls.  This command, defined in the modem database, 
is used to set the modem to communicate at only 2400 baud and automatically answer 
incoming calls. 

Phone Book Button - Opens the Phonebook Entries Dialog described in the following 
section. 

Phonebook 
The phonebook contains a list of phone numbers used to call remote DDC systems. To access the phone 
directory,  open the Program Options Dialog, select the communications page and press the Phonebook 
button.  The Phonebook Entries Dialog will be displayed. 

 
Phonebook Entries Dialog 
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Adding an New Phonebook Entry 
To add an new Phonebook entry, Press the Add button. The Phonebook Entry Dialog shown in following 
figure will be displayed.  Enter a Name and Number.  Press OK to add the new entry to the phonebook 
database. 

 

 
Phonebook Entry Dialog 

Name - The name used to identify the new location.  It will be used whenever a number needs to be 
selected. 

Number - The phone number used to call this location.  This value can contain phone numbers, 
extensions, calling card information, etc.  by using “special” characters listed in the following table.  
For example, if 9 is required to get an outside line, the number is (813) 541-3531, and the extension 
is 999, then enter  “9W1-813-541-3531,999” (without the quotes). 

 

Deleting  a Phonebook  Entry 
To remove a phone number from the database, select the entry you want to delete from the list and press the 
Remove button.  When prompted to confirm the deletion,  press Yes to remove the entry from the database. 

Changing a Phonebook Entry 
To change an existing phone number, select the entry you want to change from the list and press the Change 
button.  The Phonebook Entry Dialog box will appear.  Change the name and number as desired and press OK 
to update the database. 
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General Program Options 
To access the General options page, click the “General” tab located near the bottom of the dialog box.  The 
following screen will be displayed.   

 
General Options 

Units 
The DDC monitor has the ability to display Temperature, Air Flow, and Pressure in different 
measurement units.  The following units are available: 

Temperature - Display temperature in Fahrenheit (°F) or Centigrade (°C). 

Air Flow - Display air flow in Cubic Feet Minute (CFM), Liters Per Second (L/S), or Cubic 
Meters Per Hour (CMH). 

Pressure - Display pressure in Inches of Water Gauge (in w.g) or Pascal (Pa). 

Auto-Disconnect 
This feature allows the user to select the time, in minutes,  used for automatic network log off.   If 
there has been no user input (key presses, mouse clicks, etc.) for the specified time, the program will 
automatically disconnect from the DDC network.  Entering  0 disables the auto-disconnect feature. 

Saving the Default Options 
Check the Defaults checkbox as shown below to save the current program options.  If the options are saved, 
they will become the default program options which are loaded each time the program is run.  If the options 
are not saved, they will be active only during the current session. 

 
Setting Default Program Options
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Chapter 5 

The Network Monitor 

Connecting to the DDC Network 
Before attempting to connect with the DDC network, make sure all cables are properly configured and the 
program options have been set.  If the Connect to Network Dialog is already open, press the Connect 
button.  If it is not already open, choose Connect from the Network menu first. 

 
Connect to Network Dialog 

The program will begin searching for a network controller based on the network cards selected in the program 
options.  After a card has been found, the program will synchronize itself with the network polling cycle.  This 
process can take up to 20 seconds so please be patient.  The search and synchronize status can be monitored 
by watching the status bar at the bottom of the screen.  When a connection to the network has been established 
the Network Monitor Screen will be displayed. 
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The Network Monitor Screen 
The Network Monitor screen displays operational status information from the selected system.  The 
information from the SCU and BTC may or may not be displayed depending upon the network cards selected 
in program options. The information displayed on this page is updated continuously and can only be changed 
using one of the SCU, BTC, or Zone configuration screens described later in this manual.   

 
Network Monitor Screen 

System Address 
This value displays the system address of the selected system.  The address can be changed using the 
up and down arrows located just to the right of this value.  If the connection was not established in 
Inter-System mode, the address cannot be changed. 

System Control Unit (SCU) 
Information from the SCU on the selected system.  

Identifier -The 16 character alpha-numeric identifier assigned to the SCU. 

Occupied Mode - The current occupied mode: occupied or unoccupied. 

Time - The current time from the battery backed real time clock. 

Date - The current date from the battery backed real time clock. 

*Control Mode - The current control mode: Heating, Cooling, Ventilation, or Standby. 

*Discharge Temperature - The current AHU discharge temperature. 

* Only Appear if AHU is selected in program options. 

Bypass Terminal Controller (BTC) 
Information from the BTC on the selected system.  

Identifier - The 16 character alpha-numeric identifier assigned to the SCU. 

Static Pressure - The actual static pressure being measured. 
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Zone Controller Grid 
Information from the zone(s) on the selected system.  This grid contains 64 rows, one for each 
possible zone.   If a zone is unavailable or not responding, the information will be left blank. 

Zone - Displays the zone number and 16 character identified.  An “X” will appear at the left 
of this field when the information from the zone is being updated. 

Space Temp - Current room temperature. 

Heating Setpoint - Current heating setpoint  

Cooling Setpoint - Current cooling setpoint. 

Temp Offset - The difference between the space temperature and the heating of cooling 
setpoint.  If the space temperature is below the heating setpoint, the offset will be the 
HeatingSetpoint - SpaceTemp displayed as a negative number in blue.  If the space 
temperature is above the cooling setpoint, the offset will be the SpaceTemp -
CoolingSetpoint displayed as a positive number in red.  If the space temperature is within 
the heating and cooling setpoints the offset will be zero. 

Airflow Actual  - Current VAV terminal airflow. 

Airflow Setpoint - Airflow setpoint. 

Duct Temp - Current duct temperature measured by the zone controller.
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Chapter 6 

The System Control Unit 

Monitor Screen 
The Monitor screen displays the current operational state of the System Control Unit.  The information 
displayed on this screen is updated continuously and cannot be changed.  Any setpoint or parameter changes 
must be made using the configuration screens discussed in later sections. 

 
SCU Monitor Screen 

Zone Controllers  
This fields in this group contain VAV terminal communication and voting information.  This 
information is calculated by the SCU once after each polling cycle. 

Number Responding - The number of VAV terminal controllers currently responding to the 
System Control Unit. 

Cooling Demand - Cooling demand level recorded during the last polling cycle.  It is the 
sum of the cooling demand levels from all zones on this system. 

Heating Demand - Heating demand level recorded during the last polling cycle.  It is the 
sum of the heating demand levels from all zones on this system. 

Overriding Zone - Unit address of the last zone, encountered during the last polling cycle, 
on which the unoccupied override button has been pushed. 
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Scheduling 
The time and date from the battery backed real time clock and the schedule day being used to control 
occupied status. 

 Date - Current date in day/month/year (dd/mm/yy) format. 

Time - Current time in hour/minutes/seconds (hh:mm:ss) format. 

Day - Current schedule day.  One of the following values will be displayed: 

Sunday … Saturday: The SCU occupied/unoccupied mode is being control by the 
normal weekday Occupied Schedule times. 

Holiday: The SCU occupied/unoccupied mode is being control by the holiday 
Occupied Schedule times because the date falls within one of the periods defined in 
the Holiday Schedule. 

Zone Override: The SCU is in occupied mode because one or more zones are in 
override. 

External Override: The SCU is in occupied mode because the External Override 
input (Outside Air Temperature) has been shorted. 

Cycle Timers (only apears if AHU selected in program options) 
Mode of operation timer information. 

Cooling to Heating - Ventilation cycle time remaining during the change from 
cooling to heating. 

Heating - Heating cycle time remaining until a mode change decision is made. 

Heating to Cooling  - Ventilation cycle time remaining during the change from 
heating to cooling. 

Cooling  - Cooling cycle time remaining until a mode change decision is made. 

Air Temperature (only apears if AHU selected in program options) 
System temperature information. 

Discharge Temperature - Air handler unit discharge temperature. 

Return Temperature - (Optional) Air handler unit return air temperature. 

Outside Temperature - (Optional) Outside air temperature. 

Output Control  
System mode and SCU output status. 

Operating Mode 
Current System Control Unit mode information. 

Top Row - The occupied mode: Occupied or Unoccupied.  

Bottom Row - The control mode: Cooling, Heating, Ventilation, or Standby. 

Contact Closure Status 
This grid displays information pertaining to the SCU output relays. 

Left Column - Displays output relay assignments. 

Center Column - Displays output relay status: On or Off. 

Right Column - Displays output relay Anti-Cycle timer. 
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Outside Temp Cutoff - Used with any local heat capable zone terminal.  Designates the 
outside temperature limit above which local heat should not be energized. 

 

Floating Point Modulation   
Tri-State local heat control parameters. 

Start Offset - The number of degrees below heating setpoint at which the floating point hot 
water valve will begin to open. 

Throttling Range - The number of degrees below the Start Offset at which the floating point 
hot water valve will be fully open. 

Valve Full Stroke - The travel time, in seconds, between the fully closed and fully on the 
floating point hot water valve. 

Valve Min Step - The minimum amount of time that the floating point hot water valve open 
or close output can be energized. 

 

Proportional Modulation   
Proportional local heat control. 

Start Offset - The number of degrees below heating setpoint that either the modulating hot 
water valve will begin to open or the SCR will begin to energize the electric heat. 

Throttling Range - This parameter designates the number of below the Start Offset that either 
the modulating hot water valve will be fully open or the SCR will turn the electric heat fully 
on. 

 

Analog Output 
Proportional local heat control. 

Full On - The DC voltage at which the modulating hot water valve will be fully open or the 
SCR will turn the electric heat fully on. 

Full Off - The at which the modulating hot water valve will be fully closed or the SCR will 
turn the electric heat fully off. 
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Control Commands 
Keyboard Commands 
The following keyboard commands are available from any Zone Controller screen.  The list does not contain the 
keyboard shortcuts for menu commands described in the next section. 

 

Popup Menu Commands 
The Zone Controller popup menu, shown below, can be activated By pressing F10 or right-clicking on any Zone 
Controller screen.  These commands are used mainly for testing, but may prove useful in other situations. 

 
Zone Controller Command Menu 

Change Mode 
Occupied - Puts the controller in occupied mode. 

Unoccupied - Puts the controller in unoccupied mode. 
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Normal - Return this Zone controller to Normal mode and activate the new network address if 
it has been changed.  After the Zone controller network address has been changed, the old 
address will still be used until this command is issued or the controller is reset. 

Normal All Units - Sends the “Normal” command to all zone controllers. 

Digital Outputs 
Open Damper - Turns the open damper output on and sets the analog output to setpoint “off”.  
All other outputs are turned off. 

Close Damper - Turns the close damper output on and sets the analog output to setpoint 
“off”.  All other outputs are turned off. 

Fan On - Turns the fan output on and sets the analog output to setpoint “off”.  All other 
outputs are turned off. 

1st Stage Heat On - Turns the first stage heat output on and sets the analog output to 1/3 
setpoint “on”.  All other outputs are turned off. 

2nd Stage Heat On - Turns the second stage heat output on and sets the analog output to 2/3 
setpoint “on”.  All other outputs are turned off. 

3rd Stage Heat On - Turns the third stage heat output on and sets the analog output to 
setpoint “on”.  All other outputs are turned off. 

Turn All Outputs Off - Turns all digital outputs off and sets the analog output to setpoint 
“off’. 

Analog Outputs 
Set to Minimum - Sets the analog output to maximum; approximately 10 Volts. 

Set to Maximum - Sets the analog output to minimum; approximately 0 Volts. 

Airflow 
Set to Minimum - Set controller to minimum cool airflow for offset calibration.  

Set to Maximum - Set controller to maximum cool airflow for slope calibration. 

Set All to Minimum - Sends the “Set to Minimum” command to all zone controllers. 

Set All to Maximum - Sends the “Set to Maximum” command to all zone controllers. 

Reset Controller 
This selection issues a software reset command to this system control unit.  Sometimes, it may be 
necessary to reset the controller in order to resume normal operations.  For example,  the controller can 
become  “locked up” due to voltage spikes on the power supply or communication lines.  This solution 
might be easier than removing power from the system, especially when dealing with a remote location 
via modem. 

Clear Override Timers 
Clears all override timer registers.   This information is generally used to  charge tenants for excess 
energy usage. 

Suspend Automatic Polling 
Suspends the polling cycle until it is either re-enabled or the network connection is ended.  It is useful 
when making many modifications to the controller configuration.  By suspending the polling cycle, the 
8 second delay that occurs once each minute can be avoided.  NOTE: During the polling cycle, the 
SCU gathers control information from zones with the same system address. When automatic 
polling is suspended, the SCU will not be receiving this information and thus will not change the 
control mode based on heating or cooling demand from the zones.
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Chapter 9 

Controller Configurations 
Overview 

The DDC Monitoring program has the ability to save and restore controller configurations.   The configurations 
are stored in binary files with the following extensions: 

 
Configuration File Extensions 

 

These files contain address, password, calibration, and setpoint information.   Currently, the configuration from 
each controller must be stored individually.  Future versions may allow an entire system to be saved and 
restored. 

 

Saving Configurations 
Configurations can only be saved while one of the Monitor or Configurations screens for the desired controller 
is active.  For example, if you want to save information from Zone 210, open the Monitor screen for that Zone 
by double clicking on it in the Network Monitor zone grid.   To save the configuration, unlock the controls, and 
choose Save Configurations from the File menu.  The following screen will be displayed as the program reads 
information from the controller. 

 
Read Information from a Controller 
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When the entire configuration has been read successfully, you will be prompted to choose a file as shown below.  
Select an existing file or enter a new file name.  Press OK to save the configuration. 

 
Selecting a File to Write 

Loading Configurations 
Configurations can only be loaded while one of the Monitor or Configurations screens for the desired controller 
is active.  For example, if you want to load information into Zone 210, open the Monitor screen for that Zone by 
double clicking on it in the Network Monitor zone grid.   To load the configuration, unlock the controls, and 
choose Load Configurations from the File menu.  You will be prompted to select a configuration file to load. 

 
Selecting a file to Read 

Choose a file and press OK.  You will be prompted to select the types of information to load into the controller.  
The following types are available: 

Address - The network address used to communicate with this controller.  If loaded, the new address 
will not take affect until the controller is reset or a “Normal Mode” command is issued. 

Password - This choice is only available on the SCU.  If selected, the password will be changed.  
Unless you are absolutely sure that you know the password in the configuration this option should not 
be selected.  If a password that you do not know is loaded, you will not be able to get back into the 
system to make further changes. 
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Calibration - The values used to adjust or calibrate the sensors connected to a particular controller.  
These values should only be loaded into the same controller from which they were saved.  If the 
calibration values are loaded into a different controller, there could be substantial errors in sensor 
readings. 

Setpoints - All other user configurable parameters used by the controller including: heating cooling, 
and airflow setpoints, heating and cooling control, schedules, etc. 

 
Selecting the types of Information to Load. 

Select the desired information, press OK.   The program will write the information to the controller as shown in 
the following figure.  

 
Writing Information to a Controller
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Chapter 10 

The Modem Setup Program 
Starting the Program 

The Modem Setup Utility program gives you the ability to add, edit, and delete modem configurations from the 
DDC modem database.  It can also be used to prepare a modem for use with remote DDC Network connections.   
To run the program, double click on the Modem Setup Icon in the DDC Monitor Program group.  The main 
program screen will be displayed.   
 
A modem used on the DDC side of the connection is not under any form of computer control.  For this reason, it 
must be configured properly prior to use.  To set up a modem connected to your System Controller, Select 
"SCU” from the "Modem Set" radio box located in the upper right hand corner of the screen and connect the 
modem to your computer for configuration. 

To set up a modem connected to your computer, Select "PC” from the "Modem Set" radio box located in the 
upper right hand corner of the screen.  

 

 
Modem Setup Main Screen 

The Modem Database 
Modem Information 
The Modem Information dialog must used to modify an entry in the modem database.  This dialog will be 
opened when adding a new modem, or editing an existing modem.  Three pages of information are available: 
General Information, Commands, and Result Codes.
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General Information 
To access the General Information page of the Modem Information dialog box, select the “General 
Information” tab.  The following information is available. 

 
Modem General Information Dialog 

Modem Name - The name used to identify this modem entry in the database.   

Lock DTE Rate - Some modems automatically change the modem-computer speed (DTE baud rate) to 
match the speed of the modem-modem connection.  If the modem changes its DTE speed and the 
computer does not, the two will be unable to communicate.  The same problem occurs if the computer 
changes its speed, but the modem does not.  Selecting option synchronizes the modem and computer by 
telling the computer NOT to adjust its speed when a connection is established. 

Baud Rate - The default baud rate used by the modem. 
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Commands 
To access the Commands page of the Modem Information dialog box, select the “Commands” tab.  The 
following information is available. 

 
Modem Configuration Dialog 

Initialize - The command  string used to initialize the modem.  By default, use “ATZ^M” which is a 
standard Hayes initialize command. 

 
Configure - The command string used to configure modem for operation.  Consult your modem 
manual for the suggested optimum configuration string.  This entry may need to be set by “trial and 
error” especially when trying to communicate with modems from different manufactures.  Please note 
that you must include the following:   

  
 1.  Reset to factory configuration. 
 2.  DTE rate follows connection rate. 
 3.  DTR always on (Override). 
 4.  Connection speed = 2400 
 5.  No flow control. 
 6.  Answer on first ring. (for remote modem only) 

ETVT Mode - Currently, the DDC Network can only communicate at 2400 baud.  Modems connected 
to DDC systems for remote connections must be set to answer incoming calls.  This command string 
should set the modem to answer incoming calls on the first ring, usually “ATS0=1”, and to connect 
only at 2400 baud.  Consult your modem manual for the proper commands.  Be sure to put a “^M” 
sequence at the end of the command. 

Dial - The command string used to tell modem to start dialing (dialing prefix command).  By default, 
use “ATD” which is a standard Hayes dial command.  It will be followed by the phone number and the 
dial suffix listed below. 

Dial Suffix - The command string used to indicate end of dialing string.  By default, use “^M”. 

Cancel - The command string used to cancel a dialing operation in progress. 

Answer - The command string used to answer an incoming call. 

Hangup - The command string used to tell modem to hang up.  By default, use “ATH” which is a 
standard Hayes hangup command. 
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Return Codes 
To access the Return Codes page of the Modem Information dialog, select the “Return Codes” tab.  The 
following information is available. 

 
Modem Result Codes Dialog 

Okay - This response is returned by the modem in an “Okay” condition.  It indicates that the last 
command has been successfully executed. 

Error - Response sent back from modem in an “Error” condition.   It indicates that an error occurred 
during the last command. 

No Dialtone - This response is returned when the modem attempts to Dial, but does not detect a 
dialtone. 

Busy - This response is returned when the modem detects a busy signal during a Dial attempt. 

Ring - This response is returned when the modem detects the phone ringing signal during an incoming 
or outgoing call. 

No Carrier  - Response sent back from modem in a “No Carrier” condition.  This response will be 
returned when the modem is unable to establish a connection or when a connection is lost. 

Voice - This response is returned when the modem detects that a person, instead of a modem, answered 
during a dial attempt.   

Connect - Response sent back from modem after a connection with another modem has been 
established. 

Editing a Modem 
Select a Modem from the list and press the Edit button.  The Modem Information dialog box will be displayed.  
Make the appropriate changes and press OK.  You will be prompted to confirm.  Select Yes to update the 
database. 
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Adding a New Modem 
To Add a new modem to the database,  press the Add button.  The Modem Information dialog will be opened 
with a new modem entry;  all information will be blank.  Using the descriptions under “Modem Information” fill 
in all fields.   When finished,  press the OK button.  You will be prompted to confirm.  Select Yes to add the 
new modem to the database. 

Removing a Modem 
To remove a Modem from the database, highlight the modem name and press the Remove button.   You will be 
prompted to confirm.   Select Yes to remove the modem from the database. 

Preparing a Modem for SCU Connection 
A modem can be used to establish a remote connection to a DDC Network.  This gives the operator the ability to 
call, monitor, and configure a DDC systems from a location where a physical connection is not possible.   The 
modem used on the DDC side of the connection is not under any form of computer control.  For this reason, it 
must be configured properly prior to use.  To set up a Remote modem connected to your System Controller, 
Select "SCU” from the "Modem Set" radio box located in the upper right hand corner of the screen and 
connect the modem to your computer for configuration. 

The Setup Modem Dialog 
To prepare a modem for remote operation, select an entry from the modem list and press the Setup button.   The 
Setup Modem dialog box will be displayed. 

 
Setup Modem Dialog 

Modem - Information for the modem about to be configured. 

Name - (Read Only) The name of the database entry used to configure the modem.  This value can only 
be changed by selecting a different modem from the main screen before the Setup button is pressed. 

Write command - Command string used to save the modem configuration to non-volatile memory.  
The “AT&W0” is the standard Hayes command used to write the modem configuration to non-volatile 
memory.  If your modem requires a different command, this command should be changed accordingly. 

Serial Port - The computer serial port which is connected to the modem.  The selected port must be 
configured properly in the computer CMOS configuration and in the Windows control panel or device 
manager. 

Configuring the Modem 
When all of the information in the Setup Modem dialog box has been properly set, press OK to configure the 
modem.  Pressing Cancel will close the dialog box without configuring the modem.





Guide to Using the DDC Network Software The Set Address Program  ••••   57 

Chapter 11 

The Set Address Program 
Overview 

The Environmental Technologies  DDC (ETVT II) system uses a communications protocol known as ETIquette  
II.  It is a simple read/write protocol used to transfer data between a Computer, SCU, BTC and Zone controllers.  
When a DDC controller leaves the factory, it will be configured with a default network address.  However, for 
proper network operation, each controller must be given a unique network address.  The Set Address program 
can be used to easily change the network address of any DDC controller before, or after, it has been connected 
to the network. 

Using the Program 
Starting the Program 
To run the Set Address program, double click on the Set Address Icon in the DDC Monitor Program Group.  
The main screen will be displayed. 

 
Set Address Main Screen 

Address - (Read Only) The current network address being used by this controller. 

Identifier - (Read Only) A 16 character name used to identify  this controller. 

Version - (Read Only) The current firmware (EPROM Software) version 

Revision - (Read Only) The current firmware revision. 

New Address - The place to enter the new address for this controller. 

Establishing a Connection  
Connect the computer to a DDC controller using an ETI Quick-Connect cable.  The 6-pin end of the cable must 
be plugged directly into the controller being addressed.  Click the Connect button to open the Serial Port 
dialog box shown below.  Select the computer serial port used for network communications and press OK. 

 
Serial Port Dialog Box 
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The program will begin communicating with the connected controller within a few seconds.   

Changing the Network Address 
To change the controller address, enter a new address in the “Enter New Address” box and press ENTER. The 
address must be valid or it will not be accepted by the controller. The following table lists the range of valid 
addresses for each controller type. 

 

 

 

If a valid address has been entered,  the new address should appear in the Address field within a few seconds. 

Connecting to a Different Controller 
The controller continuously sends read commands to the controller. If it does not receive a response within a 
predetermined amount of time, it will clear the information on the screen.  When it receives a response, the 
displayed information is updated.  Because the program never stops trying to read this information, it is not 
necessary to close or stop the program when switching to a different controller. 


